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Copyright and Trademarks 
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1 System Requirements 
Below are the minimum system requirements for the computer where you install iControl. To verify the 
operating system and hardware configuration, right-click My Computer, select Properties, and review the 
General tab. 

 ONE iC/iControl Application 
(Minimum Requirements) 

MULTIPLE iC/iControl Applications 
(Minimum Requirements) 

CPU Intel Core 2 Duo 2.2 GHz T7500 (Notebook) or 
Intel Core 2 Duo 2.4 GHz E4600 (Desktop) 

Intel Core 2 Duo 2.5 GHz T9300 (Notebook) or 
Intel Core 2 Duo 2.8 GHz E8300 (Desktop) 

Memory 2 GB 3 GB 

Hard Drive SATA 5400 rpm SATA 7200 rpm 

Graphics SXGA 1280 x 1024  
with 3D hardware acceleration, including  
Vertex Shader, Pixel Shader, Texture Support, 
and Lighting  

SXGA 1280 x 1024 
with 3D hardware acceleration, including  
Vertex Shader, Pixel Shader, Texture Support, 
and Lighting  

Supported operating systems are:  

Microsoft Windows 7 (64-bit with Office license only) 
Microsoft Windows Vista, SP1 (64-bit with Office license only) 
Microsoft Windows XP, SP3 

Additional software requirements include Internet Explorer 7.0, Microsoft Office 2003 or 2007, and Adobe 
Reader 7 or higher (The latest version of Acrobat Reader is recommended). 

2 Deployment Package 
2.1 Contents of the iControl LabMax™ 5.0 CD-ROM 

• iControl LabMax™ 5.0 software (Autorun.exe) 
• iControl Data Conversion Utility 
• iControl LabMax™ 5.0 Release Notes in English  
• iControl LabMax™ 5.0 Installation Guide in English (this file) 
• Firmware 3.4.2 for UCB including necessary tools and documentation 

2.2 Content of the iControl Mixing Guidelines CD-ROM 
• iControl Mixing Guidelines (Setup.exe) 
• iControl LabMax™ 5.0 Installation Guide in English 
• iControl LabMax™ 5.0 Release notes in English 
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3 Introduction 
iControl installation is wizard-driven. As soon as you start the process from the installation welcome page 
(Figure 1 on page 8), the wizard guides you through the steps to install the iControl software, starting with 
any prerequisite components.  

NOTE: The wizards and dialog boxes shown in this guide are from a Windows XP installation. The 
corresponding wizards and dialog boxes displayed for Windows Vista and Windows 7 will differ 
slightly in appearance, but the functionality is the same for each operating system. 

In addition to the installation process, this guide also includes information on administering the software, 
activating licenses, and sharing data among multiple iControl/iC applications. 
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4 Installing iControl LabMax™ 5.0 
4.1 Necessary user rights 
NOTE: You need Administrator privileges on the PC in order to successfully install the software. 

To run iControl LabMax™, normal user privileges are sufficient. 

4.2 Installing iControl LabMax™ 5.0 without updating a previous 
installation 

When installing iControl LabMax™ 5.0 on a new system without any previously installed iControl or WinRC 
versions, there are no preparation tasks to do in order to perform the installation. Please proceed to chapter 
4.5 to start the installation of iControl LabMax™ 5.0. 

4.3 Updating iControl LabMax™ 4.0 with iControl LabMax™ 5.0 
iControl LabMax™ 4.0 and iControl LabMax™ 5.0 can both be installed on the same PC, although it is not 
possible to run both applications at the same time. 

When installing iControl LabMax™ 5.0, the following data is copied from the previous iControl LabMax™ 4.0 
installation: 

• Equipment database including all device settings such as device names and COM ports 
• The last used lab equipment including defined reactor, stirrer, cover, inserts and safety limits 
• Chemical Database 
• Experiment Equipment Setup Templates 
• Sensors (UCB, RD10) including adjustment data 
• Any defined links to other iC applications 

 

After having iControl LabMax™ 5.0 installed, you are immediately ready to go with the same defined 
environment as you had in iControl LabMax™ 4.0. Experiments from version 4.0 can be opened without any 
data conversion. 

NOTE: Before starting the iControl LabMax™ 5.0 installation, please Logout or Reboot in order to close 
all active iControl LabMax™ 4.0 processes. Then proceed to chapter 4.5 in order to start the 
installation of iControl LabMax™ 5.0. 

Information about uninstalling iControl LabMax™ 5.0 can be found in chapter 12. 

4.4 Updating WinRC with iControl LabMax™ 5.0 
WinRC and iControl LabMax™ 5.0 can both be installed on the same PC, although it is not recommended to 
run both applications at the same time.  

NOTE: Before starting the iControl LabMax™ 5.0 installation, please Logout or Reboot in order to close 
all active WinRC processes. Then proceed to chapter 4.5 in order to start the installation of 
iControl LabMax™ 5.0. 

After having iControl LabMax™ 5.0 installed, please use the iControl Data Conversion Utility to convert WinRC 
experiment files (*.mtd) into the iControl LabMax™ 5.0 data format. Go to chapter 7 for further details about 
the iControl Data Conversion Utility. 
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4.5 Starting the iControl LabMax™ 5.0 installation 
NOTE: It is recommended that you close all open programs prior to starting the installation. 

When you insert your iControl LabMax™ 5.0 CD-ROM into the PC’s CD drive, the AutoPlay application should 
start. From this display, you can click on the ‘Install iControl LabMax™ 5.0 (setup.exe)’ button to start the 
installation. 

 

Figure 1: Installation welcome dialog box 

If the AutoPlay function does not start automatically, then you can also run the autorun.exe or Setup.exe 
directly from the iControl LabMax™ 5.0 CD-ROM root directory.  

The following chapters describe the installation process in detail. 

Notice:  

• Dependent on what is already installed on your computer, some of the prerequisite installation steps 
below may be skipped. 

• Some of these prerequisite installations might ask you to reboot the computer. Please do as 
requested and reboot. After you have logged in again, you might need to restart the iControl 
LabMax™ 5.0 installer by double-clicking on Setup.exe on the iControl LabMax™ 5.0 CD-ROM root 
directory. The installer will then continue to install iControl LabMax™ 5.0. 

4.5.1 Microsoft .NET Framework 3.5 SP1 

Note: This step only applies if the .NET Framework 3.5 SP1 not already exists on the computer where 
you are installing iControl.  
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Read the “License Agreement” carefully and click ‘Accept‘. 

4.5.2 Microsoft SQL Server Compact 3.5 SP1 

Note: This step only applies if the SQL Server Compact 3.5 SP1 not already exists on the computer 
where you are installing Icontrol.  

 

 

 

Read the “License Agreement” carefully and click ‘Accept‘. 
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4.5.3 iControl 5.0 ALR Components 

Note: In case the iControl 5.0 ALR Components are not already installed on your system, the iControl 
LabMax™ 5.0 installer will automatically ask you to accept the installation: 

 

To start the installation process, click ‘Install’. The installation of all prerequisites will then start. 
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4.6 iControl LabMax™ 5.0 Main application 
After the successful installation of all of the prerequisite installers, the iControl LabMax™ 5.0 main application 
installer window will be displayed: 

 Click Next. 

 

1. Review the license agreement 
and select I Agree. 

2. Click Next. 

 

3. Click Next to move through the 
installation wizard steps. 
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Folder: 

4. Accept the default, if possible. If 
another location is required, click 
Browse -make sure the Mixing 
Guidelines installation folder is 
also changed accordingly! 

Disk Cost: 

5. Click Disk Cost to review available 
disk space for the installation (see 
figure below).  

 

Install for yourself or for anyone... 

6. Accept the default (Everyone) to 
allow any valid login to use 
iControl on this computer. 
Otherwise, access to iControl will 
be limited to login ID used during 
installation (Just me). 

 

 

 

 

7. Click Next through the 
confirmation and installation 
processing wizard dialog boxes. 
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8. Click Close after successful 
completion.  

9. Proceed to 4.8 Starting the 
iControl Software page 17. 

 

4.6.1 Installed application shortcuts 

The iControl LabMax™ 5.0 installer installed the following shortcuts under your Start menu 

“Start->All Programs->METTLER TOLEDO->iControl LabMax™ 5.0”: 

Shortcut  Description 

Service Features This folder contains tools for the METTLER TOLEDO field service engineer. 

eLearning Tutorials 
iControl LabMax™ 

Web Link to online Training Videos on the AutoChem Community Webpage.  
Note: You can register on the Community Webpage for free to gain access 
to this and other interesting and important information around your 
application areas, AutoChem products and services. 

iControl LabMax™ 5.0 Main Application. Click this shortcut to start iControl LabMax™ 5.0 

Quick Reference The 2 page quick reference which gives an excellent overview over the 
main functionality. 

Release Notes PDF document which describes the known issues with iControl LabMax™ 

5.0. It is recommended to read this through to understand the currently 
known limitations. 

Send iControl Logs To 
Customer Care 

This is a utility which helps you to gather the necessary information to 
provide to METTLER TOLEDO Customer Care in case of a support issue. 

Temperature Control PI 
Estimator Utility 

For advanced users: This Excel spreadsheet is used to fine tune the PI 
control parameters for your thermostat. Details are described in the iControl 
LabMax™ 5.0 online help. 

 

The iControl LabMax™ 5.0 installer also installs a shortcut on your desktop to start the iControl LabMax™ 5.0 
application. 
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4.7 Installing the iControl Mixing Guidelines 
As with the main application installation, it is recommended that you close all open programs prior to 
starting the installation. 

When you insert your iControl Mixing Guidelines CD-ROM into the PC’s CD drive, the AutoPlay application 
should start. From this display, you can click on the ‘Install Mixing Guidelines (setup.exe)’ button to start the 
installation. Then follow the wizard steps of the installer. 

 

If the AutoPlay function does not start automatically, then you can also run the autorun.exe or Setup.exe from 
the iControl Mixing Guidelines CD ROM root directory.  

 

 

1. Click Next to move through the 
installation wizard steps. 
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2. Review the license agreement 
and select I Agree. 

3. Click Next. 

 

Folder: 

4. Accept the default, if possible. If 
another location is required, click 
Browse. 

Disk Cost: 

5. Click Disk Cost to review available 
disk space for the installation (see 
figure below).  

 

Note: The ‘Disk Cost’ may not provide 
the correct information. The iControl 
Mixing Guidelines will need 
approximately 500 MB of hard drive 
space. 

 

Install for yourself or for anyone... 

6. Accept the default (Everyone) to 
allow any valid login to use 
iControl Mixing Guidelines on this 
computer. Otherwise, access to 
the Mixing Guidelines will be 
limited to login ID used during 
installation (Just me). 
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7. Click Next through the 
confirmation and installation 
processing wizard dialog boxes. 

 

8. Click Close after successful 
completion.  

 

 

4.7.1 Installed application shortcuts 

The iControl Mixing Guidelines installer installed the following shortcuts under your Start menu 

“Start->All Programs->METTLER TOLEDO”: 

 

Shortcut Description 

Mixing Guidelines Main Application. Click this shortcut to start the Mixing Guidelines main 
page. 

Mixing Video Comparer  The Mixing Video Comparer application allows you to show and compare 
two different mixing scenarios. Note that this utility requires a valid iControl 
LabMax™ Instrument or Office License in order to work. 



 

iControl LabMax™ 5.0 Installation Guide Page 17 of 44  

iC
on

tro
l L

ab
M

ax
™

 In
st

al
la

tio
n

 

4.8 Starting the iControl Software 
1. Start the iControl software application by clicking the desktop icon or selecting iControl LabMax™ 5.0 

from the METTLER TOLEDO program menu in the Start menu. 

 or 

 

2. The following message indicates the software is running on a trial license: 

 

o If you have a License Key, click Activate Now to proceed with the registration process. Instructions 
begin under 9 iControl / iC Licensing on page 24.  

o If you prefer to remain on the 30-day trial license, click Activate Later. 

Note: The 30-day trial provides access to all iControl 5.0 features. 

4.9 Configuring LabMax Instrument (New user)  
Note: Users that updated iControl from version 4.0 to version 5.0 are immediately ready to go – there 

is no need for a reconfiguration of the instrument or equipment. 

1. Log on to the iControl LabMax™ PC and open the iControl software application. 

2. From the Start Page, click Manage Equipment, and use the Add Instrument button to configure your 
equipment. If needed, refer to the explanations in the online Help for additional details. 

4.10 Checking for Updates 
If you already have a release of iControl 5.0 installed and want to see if you have the latest version or release 
, select “Check for Updates” from Help menu. 
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5 Importing existing Equipment Database 
If you have used WinRC 7.5 or 7.6 or a previous version of iControl before, then you can import the existing 
equipment database (WinRC.mte file) into iControl LabMax™ 5.0. 

For this, start iControl LabMaxTM 5.0, press “Manage Equipment” on the Start Page, add or open the 
LabMax™ instrument and press “Import Equipment Database”. 

For more detailed information please refer to the iControl online help (search for “Import Equipment 
Database”). 

6 Converting Experiment Data from WinRC 
If you want to convert existing WinRC 7.5 or 7.6 experiments to iControl LabMax™ 5.0, then you can use the 
iControl Data Conversion Utility which is available as a separate installer on the iControl LabMaxTM 5.0 CD-
ROM in the folder “Data Conversion Utility” or more conveniently from the AutoPlay application which should 
start when you insert the iControl LabMaxTM 5.0 CD-ROM. From this display, you can click on the ‘Install 
Data Conversion Utility (setup.exe)’ button to start the installation.  

 

Alternatively you may also run the “setup.exe” in the “Data Conversion Utility” folder on the CD-ROM and 
follow the on-screen installation instructions. The installer will create a shortcut into the Windows Start menu: 
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1. Click Next to move through the 
installation wizard steps. 

 

2. Review the license agreement 
and select I Agree. 

3. Click Next. 

 

Folder: 

4. Accept the default, if possible. If 
another location is required, click 
Browse. 

Disk Cost: 

5. Click Disk Cost to review available 
disk space for the installation (see 
figure below).  

 

Install for yourself or for anyone... 

6. Accept the default (Everyone) to 
allow any valid login to use the 
Data Conversion Utility on this 
computer. Otherwise, access to 
the Data Conversion Utility will be 
limited to login ID used during 
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installation (Just me). 

 

 

 

 

7. Click Next through the 
confirmation and installation 
processing wizard dialog boxes. 

 

8. Click Close after successful 
completion.  

 

When you run the utility, you have the option between 4 possible conversions, for iControl LabMax™ 5.0 only 
the third option “Converting WinRC Experiment files” can be used: 
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NOTE: The original experiment and chemical data will not be altered during this conversion process. 

Important: Although we have tested this conversion utility carefully for several months, there is a risk that 
some experiment files may not be completely converted by the utility. If this is the case, the 
utility will show an error report. Please contact iControl Support (iControl@mt.com) for further 
assistance. 

6.1 Installed Application Shortcuts 
The iControl Data Conversion Utility installer installed the following shortcut under your Start menu 

“Start->All Programs->METTLER TOLEDO”: 

Shortcut Description 

iControl Data Conversion 
Utility 

Main Application. Click this shortcut to start the Data Conversion Utility. 
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7 UCB Firmware Update 
NOTE: In order to use an existing UCB (Universal Control Box) with iControl LabMax™ 5.0, you will 

need to update the firmware on this box. 

On the iControl LabMax™ 5.0 CD-ROM in the folder “Firmware” you will find the following firmware file: 

Box-type Version Filename 

UCB 3.4.2 AlrFirmware_iControl_UCB_x_x_x.alrfw 

This file can be used to update the UCB. 

To update the UCB firmware, open “Manage Equipment” from your iControl LabMax™ 5.0 Start Page and 
select the UCB instrument. Select the 3rd tab called “Service Tools” and click on “Download Firmware”. You 
will need to select the appropriate serial port for the UCB and browse for the firmware file mentioned above.  
Click the ‘Download’ button to initiate the transfer. 

 

For more detailed information please refer to the iControl Online help (Search for “Download Firmware”). 
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8 Installation of the Multiport Adapter 
8.1 USB - RS422 Adapter VScom USB-4COMi-SI 
The USB adapter USB-4COMi-SI will be working with Windows XP, Vista and Windows 7. The various drivers 
are found on the VScom Product Drivers and Manuals CDROM, which is shipped together with the multiport 
adapter or can be downloaded from http://www.vscom.de. 

The following chapters are a brief overview on the installation of the multiport adapter: 

 

1. Boot the system and log in with under an administrative user account. 

2. Insert the VScom CDROM into your CD drive. 

3. Check settings of the jumper on the USB multiport adapter (Jumper 1 and 2 “ON”; Jumper 3 and 4 
“OFF” as defined on the USB adapter for use as RS422 adapter). 

4. Plug the cable of the adapter into the USB port on the PC. Windows will start looking for device 
drivers since the adapter is Plug&Play. Go through the wizard and if necessary specify the 
appropriate path driver (located in the CD drive directory). The COM Port numbers are starting with 
the first available. 

5. A reboot of the system is not necessary to complete the installation. 

 

If you run into problems during the installation, please see the following problem descriptions:  

 

 Problem Solution 

1 System doesn’t recognize the new 
device 

Go to the <Control Panel>, <System Properties>, <System>, 
<Device Manager> and open the <USBDevice> (or the USB 
component with the yellow mark) and re-install the respective 
driver. Then subsequently, reboot the PC. 

2 System doesn’t find the 4 COM ports Reboot the PC 

3 COM ports are not found any more 
after unplugging and re-plugging of 
USB adapter 

Reboot the PC 

 

If this does not help, please refer to your service engineer or to the iControl Hotline at iControl@mt.com 
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9 iControl / iC Licensing 
iControl applications use a licensing scheme to control distribution and use of the software. Below are the 
types of licenses.  

• Instrument version—Enables the application to connect to a live instrument and run experiments.  

• Office version—Enables the user to run the application without a connection to an instrument. With this 
version, experiment data obtained from a computer with an Instrument license can be viewed and 
analyzed.  

• Trial version—A trial version is equivalent to an Instrument license with a 30-day time limit.  

• Module licenses—Optional add-on modules, allow access to additional features that are purchased 
and licensed separately. 

• iCare subscription—A special annual subscription that entitles you to all major and minor upgrades 
and service packs for the Instrument or Office versions of your iC and iControl Software as well as priority 
telephone and email support. Please refer to 9.4 Activating an iCare Subscription on page 28. 

• Site license—Specific companies that have large software agreements with METTLER TOLEDO may 
also have a Site License for a particular product or products. Please refer to 9.5 Installing a Site 
License on page 29.  

9.1 Using the License Manager to Activate a Single-User License 
Note: Although you need to activate your software on a Web site, the PC where you are installing the 

iControl software does not require an internet connection. You can activate the software license 
using any internet-enabled PC. 

The following information applies to users installing a single-user Instrument, Office, or Module license. The 
first time the iC application starts, the system displays the Trial License dialog. 

 

1. Click Activate Now to open the License Manager. (This dialog box can also be opened from the main 
iControl Help menu.) 
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Figure 1: License Manager dialog box 

The License Manager contains an 8-digit Machine ID and an area to input a 25-digit Activation Code 
field in 5-digit segments.  

2. Select one of the following two options: 

• Register now. 

a. Have your License Key sheet ready. (The sheet is usually a letter-size paper certificate delivered 
with the software.) 

b. Click Copy after step 1.Copy Machine ID. (Refer to Figure 1: License Manager .)  

c. In the License Manager dialog box after step 2. Activate your license key at:, click the link 
(https://community.autochem.mt.com). 

d. Obtain your Activation Code. Follow the instructions in the next section, “9.2 Obtaining an 
Activation Code from the MT Web Site.” You will need to enter your Machine ID and License Key 
to generate an activation code (see page 27). 

Note: If you purchased iCare at the same time as iControl 5.0, activate your 5.0 license first. 
Then, follow the steps on page 28 to activate the iCare subscription. 

e. Once you have copied the activation code from the AutoChem Community Web site, return to 
the License Manager (Figure 1). 

f. In the License Manager dialog box, click Paste after step 3. Enter Activation Code. 

g. Click Apply Activation Code to complete the registration process.  

• Register later and continue with a 30-day trial. 

a. Click Close without registering the software. 
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b. Use the link under Reminders on the iControl Start Page or select License Manager from the 
Help menu to register later. 

              

9.2 Obtaining an Activation Code from the MT Web Site 
Your activation code is generated through the METTLER TOLEDO AutoChem Community Web site. To obtain 
the activation code, you must have the Machine ID from the License Manager dialog box in the iControl 
software and the License Key provided on a letter-size certificate with the software. (Refer to the previous 
section on 9.1 Using the License Manager to Activate a Single-User License.) 

Note: Access the MT Web Site from any internet-enabled PC—This step does not necessarily need to be 
performed on the PC where the iControl software is installed. 

 

Figure 2  AutoChem Customer Community site 

1. Depending on whether or not you have an account, start with one of the following steps: 

• If you are a new user, begin by setting up a user account (see page 28). 

• If you already have an account, enter your username and password and click Log in under User 
login or click log in from the red prompt box.  
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2. Enter the required information and click Log in. 

 

3. Click Activate an iControl or iC License from the My Account tab. 

 

4. Enter the Machine ID and License Key or use the Paste buttons (highlighted below).  
The Machine ID can be copied from the License Manager window. The License Key is provided on a 
license certificate sheet delivered with your software. 

 

Figure 3: Activate License dialog box 

5. Click Generate Activation Code to produce the code in the text box. Then, click Copy to save the code 
to the clipboard. 

6. Return to the License Manager in the iControl software (see 24), and click Paste or type in the activation 
code in step 3. Enter Activation Code.  
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7. Click Apply Activation Code to complete the activation. You should see a dialog box that confirms the 
activation is complete. 

8. Repeat the process to activate any module licenses on the PC. 

9.3 Setting Up a New User Account 
If you do not already have a user account on the METTLER TOLEDO AutoChem Community Web site, you will 
need to create one before your licenses can be activated. 

1. From the METTLER TOLEDO AutoChem Community Web site, click the Create new account link.  

2. Enter the required information and accept the terms. 

3. Click Create new account at the bottom of the registration form. 

The AutoChem Community web site confirms that an email is being sent: 

 

You will receive an email with instructions and a link to confirm your email address and complete the 
new account registration.  

NOTE: Your Web site registration will be pending until confirmed by METTLER TOLEDO AutoChem; 
however, you can activate the software by following the link provided in the email. 

 

4. Click the first link to confirm your email. You will go to a one-time login where you create a password.  

5. After you change and confirm the password, click Save at the bottom of the page. 

6. From the Home page, select Activate an iControl or iC License under the My Account tab. 

7. Follow the instructions under 9.2 Obtaining an Activation Code from the MT Web Site on page 
26. 

9.4 Activating an iCare Subscription 
The procedure to activate an iCare subscription is similar to that for obtaining an activation code from the MT 
Web site for a single-user license, as described beginning on page 26. The 12-character iCare Subscription 
Number will be provided on an iCare Subscription Certificate sheet that shipped with your order.   
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1. Login to the METTLER TOLEDO AutoChem Community Web site. 

2. Click Activate an iCare Subscription from the My Account tab. 

 

An Activation iControl/iC License or iCare Subscription window appears with the iCare Subscription 
selected. 

3. In the iCare activation window (Figure 4), enter the Machine ID as directed in the Note, or use the Paste 
button (highlighted below). The Machine ID can be copied from the License Manager dialog box.  

 

Figure 4:  Activate an iCare Subscription window 

4. Enter or paste the Subscription Number, provided on a certificate sheet delivered with your software. 

5. Click the Activate Subscription button. You should receive a confirmation email message in a few 
minutes that provides some additional information about the program.   

6. The email will also include an iCare Subscription Activation Code that can be entered or pasted back into 
the License Manager dialog box of the iControl software.  

Activating the iCare subscription in the software itself is not required, but if you perform this step, then 
you will not need to update any licensing information if a new iControl version is released before the 
iCare subscription expires. 

9.5 Installing a Site License 
NOTE: Most companies do NOT have a site license, so only follow this procedure if specifically directed 

by your organization. 
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A Site License is supplied as a file and must be loaded into each copy of the iControl software in use. 
(Please refer to 9 iControl / iC Licensing on page 24 for an explanation of site licenses.) 

1. To install the Site License, open the License Manager by selecting it from the from the Help menu. 

 

2. In the License Manager, click Enable. 

 

3. Click Browse to navigate to the Site License file location. Then, click OK. 

 

The license loads and the software is ready to use.  

4. Repeat on the other computers with iControl installed. 
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10 Sharing Data between iC/iControl Applications 
Data can be shared between iControl and iC applications that are running on a network. To connect two PCs 
that run iControl or iC products, you must have an Ethernet connection between them. The two common 
situations are:  

• Both PCs are on the same network—either the main company network or a lab network.  

• Each PC is standalone with an Ethernet cross-over cable that connects them. (Cross-over cables are 
available at almost any computer supply store.)  

10.1 Before You Begin 
1. Ensure that the iControl and iC applications are installed and operating properly on each PC, meaning a 

user can successfully execute an experiment with a ReactIR instrument.  

2. Verify that the major versions of the products are release 4.0 or higher to ensure compatibility. 

3. Ensure that the two PCs are connected by one of the methods described at the beginning of this section. 

NOTE: Any PCs that will be coordinating live experiments should have the same regional settings and be 
in the same time zone. 

10.2 Connecting iC/iControl Applications 
For iControl/iC applications running on different PCs on the same network, the applications must first connect 
to each another. Below are the steps to get the iControl/iC applications on the separate PCs to connect.  

1. Start the iControl or iC application on each PC.  

2. On one PC, connect to the iControl or iC software that is running on the other PC.  

• For iC applications—Go to the main Tools menu and select “Connect to other iC/iControl applications…”  

 

• For iControl—Go to Manage Equipment and add a new device of the appropriate type. For 
example, iC FBRM 4:  
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Click the Find Mettler-Toledo applications button on the device configuration screen: 

 

3. Find applications using the “Connect to other iC/iControl applications” dialog box.  

 

a. On each PC, click the Find Application button to begin a network scan for the other applications.  

Once this initial scan is performed, the Application Type list displays all iC/iControl applications 
currently running the Find Application process on the network. On each PC, the corresponding 
applications should appear on the list and the Status column should show Connected (as shown 
for iCFBRM in the sample below).  

  

NOTE: If an application connection cannot be made, the Application Type column entry is 
“Unknown.” Please refer to Getting PCs to Communicate (TCP/IP) on page 33. 

There is no need to rescan the network PCs in the future unless a new iC/iControl application or PC 
running an application is added to the network. In this case, a scan must be run on all PCs to 
update the Application Type list. 

Once communications between the iC/iControl applications has been established, trend data for the 
applications display in the Result List Add Trends list. 
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b. Close the connection list dialog box and test the connections.  

In iControl, click the Test Connection button on the iC device configuration dialog box. 

NOTE: There is no corresponding test in iC—Use the checks below for testing.  

4. To verify that the connection is working for all aspects of the software application, perform the following 
checks:  

iControl-to-iC connection  

a. In iControl, start a new experiment and include the iC device in the equipment setup.  

b. Execute the run and verify that you can start a new iC experiment from the iControl wizard. 

c. Verify that the iC experiment starts when the iControl experiment starts.  

d. Check that the iC operations can be used in the iControl procedure (for example, Change Sample 
Interval, Pause, etc.).  

e. Add iC trends to the iControl Trend Viewer.  

f. Try another iControl experiment that specifies a template file for the iC IR experiment that iControl will 
start. When starting an iC experiment from the iControl experiment Start wizard, the template should 
be automatically selected for the iC experiment. 

NOTE: The path for the template file should be from the iC application point of view. 

iC-to-iControl connection  

a. Add iControl trends to the iC Trend Viewer. 

b. Verify that live trends from iControl are correctly updated in a live iC experiment. 

If you have trouble getting the applications to talk, then you can execute the procedure described next under 
Getting PCs to Communicate (TCP/IP). 

10.3 Getting PCs to Communicate (TCP/IP) 
Follow the steps below to establish communications between the two PCs: 

1. Find out each PC’s name.  

a. Right-click on the My Computer icon (on the Desktop) or from the Start menu, and select Properties.  

b. Select the Computer Name tab in the System Properties dialog box and note the “Full computer 
name.” 

NOTE: Make sure each PC has a unique name or they will not be able to communicate. 
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2. Find out the IP address for each PC. 

a. Open a Command prompt (Start > Run > Type cmd in the Run dialog box > Click OK).  

 

b. Type ipconfig and press Enter.  

 

3. If there is no IP address specified (or the address is 0.0.0.0), specify one using the instructions in the 
10.4 Troubleshooting the Connections section on page 35 before continuing to the next step.  

4. Ping the other PC.  

a. Open the Command prompt window again.  
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b. Type ping followed by a space and the name of the other PC.  

c. You should get a series of replies from the other PC—If you see ‘Request timed out,’ the other PC 
cannot be reached via TCP/IP.  

 

5. If the PCs can ping each other by name, go to 10.2 Connecting iC/iControl Applications on page 
31.  

If the PCs cannot ping, follow the steps in the 10.4 Troubleshooting the Connections section.  

10.4 Troubleshooting the Connections  
If you are still having trouble getting the PCs to communicate or getting the iC/iControl applications to 
successfully communicate, try one of the following suggestions: 

• 10.4.1 Diagnose Firewall Issues (procedures begin below) 

• 10.4.2 Update the HOSTS File on the PC (procedures begin on page 36) 

• 10.4.3 Specify a Particular IP Address for the PC (procedures begin on page 37) 

NOTE: You should always stop and restart the iC or iControl applications (including their services) after 
changing any of the networking information described below. Rebooting the PC is the easiest way 
to do this. 

10.4.1 Diagnose Firewall Issues  

If permitted, the best way to check whether firewall issues are causing communication issues is to disable 
the service.  

1. Open the Services view (Control Panel > Administrative Tools > Services).  

2. Double-click on the Windows Firewall service to display the properties.  
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3. Click Stop the service. Then, select Disabled from the Startup type drop-down list. 

4. Click OK to save changes. 

If disabling the firewall solves the communication issues, investigate setting up exceptions within your 
firewall to enable iC/iControl communications along with firewall protection. 

10.4.2 Update the HOSTS File on the PC 

This method “hard codes” the IP address in the HOSTS file on the PC.  

1. Open Windows Explorer and drill down to the C:\Windows\System32\Drivers\etc folder.  

NOTE: The directory may be C:\WIN\System32, or some other name like ‘windows.’ If the directory 
has a System32 subdirectory, then you are in the right place. 

 

2. Locate the HOSTS file and open it with Notepad. 

3. Add two new entries—one for the other PC and one for this PC—with the appropriate IP addresses. 
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4. Save the file.  

NOTE: Make sure you do not inadvertently add a .txt file extension—This HOSTS file should have NO 
extension. 

5. Repeat this procedure on the other PC. 

10.4.3 Specify a Particular IP Address for the PC 

1. Under the Control Panel, find and open the Network Connections dialog box. 

2. Right-click on the appropriate connection (usually ‘Local Area Connection’) and select Properties.  

3. Scroll through the list box until you find Internet Protocol (TCP/IP), select it, and click the Properties 
button. 

 

 

4. Select the Use the following IP address radio button. 
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5. Enter an IP address (ideally, the addresses for the two PCs should differ only by the 4TH
 number).  

6. Enter a Subnet mask of 255.255.255.0 and click OK.  

If you continue to have issues connecting to other iC/iControl applications, send an email to 
iControl@mt.com for assistance. 
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11 Supporting and Repairing the iControl 
LabMax™ Installation 

To access support information and to repair your installation, click on ‘Control Panel’ in your start menu on 
your computer: 

 

 

This will open your control panel: 

 

 

 

Double-click ‘Add or Remove Programs’. 

Note: On German versions of Windows, this item is called ‘Software’ 

 

Depending on your installation, you may see the following entries: 
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If you select an item in the list, such as ‘METTLER TOLEDO iControl LabMax™ 5.0’, the view of this item will 
expand to show more information. 

 

 

 

From here, you can access the support email and webpage information. 

  

You have the option to repair your iControl LabMax™ 5.0 installation by clicking on the ‘Change’ button. 
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12 Uninstalling iControl LabMax™ 
12.1 Uninstalling the iControl LabMax™ 5.0 application 
Note: Uninstalling iControl LabMax™ 5.0 will not uninstall or delete any experiments, equipment database, 
license activation or user settings – all data is retained.  So after you reinstall iControl LabMax™ 5.0 (or 
install a future version of iControl LabMax™), all of your data will be accessible again.  

 

To uninstall the iControl LabMax™ 5.0 application, open ‘Add or Remove Programs’ from the ‘Control Panel’ 
(see the previous chapter for details) and select the ‘iControl LabMax™ 5.0’ entry: 

 

 

 

Click on the ‘Remove’ button. This will start the removal process. Follow the instructions in the uninstall 
wizard. 

12.2 Uninstalling iControl Mixing Guidelines 
To uninstall the iControl Mixing Guidelines, open ‘Add or Remove Programs’ from the ‘Control Panel’ (see the 
previous chapter for details) and select the ‘iControl Mixing Guidelines’ entry: 

 

 

 

Click on the ‘Remove’ button. This will start the removal process. Follow the instructions in the uninstall 
wizard. 

12.3 Uninstalling previous iControl installations 
When uninstalling a previous iControl installation such as iControl 4.0, assure that you only remove the 
iControl installation and the ALR Service Tools 4.0 if installed. Do not remove any METTLER TOLEDO ALR 
Components installations. 

 

Remove entries marked with a  in order to uninstall a previous iControl installation. 
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12.4 Uninstalling Prerequisite Software 
Please note that iControl LabMax™ 5.0 and the iControl Mixing Guidelines require several prerequisite 
applications to run. Uninstalling any of the prerequisite applications may lead to unexpected behavior of the 
iControl LabMaxTM software. The following table shows the required prerequisites per product: 

 Mettler Toledo ALR 
Components 5.0 

Mettler Toledo 
Service Tools 5.0 

Microsoft .NET 
Framework 3.5 
SP1 

Microsoft SQL 
Server Compact 
3.5  

iControl LabMax™ 

5.0 
x x x x 

iControl Mixing 
Guidelines 

  x  

12.4.1 Uninstalling iControl ALR Components 

Note: iControl requires the ‘iControl ALR Components’ to run. Do not uninstall the ‘iControl ALR Component’ 
as long as you need the ‘iControl LabMax™ 5.0’ application 

To uninstall the iControl ALR components, open ‘Add or Remove Programs’ from the ‘Control Panel’ (see the 
previous chapter for details) and select the ‘iControl ALR components’ entry. Then click the ‘Remove’ button. 
This will start the removal process. Follow the uninstall wizard instructions. 

12.4.2 Uninstalling Microsoft SQL Server Compact 3.5 

To uninstall Microsoft SQL Server Compact 3.5, open ‘Add or Remove Programs’ from the ‘Control Panel’ 
(see the previous chapter for details) and select the ‘Microsoft SQL Server Compact 3.5’ entry. Then press 
‘remove’. This will start the removal process. Follow the uninstall wizard. 

12.4.3 Uninstalling Microsoft .NET Framework 3.5 

Note: Microsoft .NET Framework 3.5 is a basic infrastructure component of your Windows operating system 
and therefore uninstalling it is not recommended. 

To uninstall the Microsoft .NET Framework 3.5, open ‘Add or Remove Programs’ from the ‘Control Panel’ 
(see the previous chapter for details) and select the ‘Microsoft .NET Framework 3.5’ entry. Click on the  
‘Change/Remove’ button. This will start the removal process. Follow the uninstall wizard instructions. 
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13 Installation / Operations Guidelines for IT 
Departments 

This section is intended for IT departments to help them understand the minimal user privileges needed to 
install and run iControl LabMax™ 5.0. 

NOTE: The below mentioned paths are only applicable to Windows XP. Paths on Windows Vista and 
Windows 7 may be slightly different. 

13.1 Installation privileges 
The installation of iControl LabMax™ 5.0 and the iControl Mixing Guidelines requires administrative 
privileges. 

13.2 Execution privileges 
To operate iControl LabMax™ 5.0 and the iControl Mixing Guidelines normal user privileges are sufficient. 

13.3 Folders access privileges 
To operate iControl LabMax™ 5.0 and the iControl Mixing Guideline, the logged in user needs read access to 
the following folders including all subfolders: 

<Drive>:\Program Files\METTLER TOLEDO 

To operate iControl LabMax™ 5.0 and iControl Mixing Guideline, the logged in user needs read/write access 
to the following folders including all subfolders: 

<Drive>:\Documents and Settings\All Users\Application Data\METTLER TOLEDO 

<Drive>:\Documents and Settings\<UserName>\Application Data\METTLER TOLEDO 

<Drive>:\Documents and Settings\<UserName>\Local Settings\Temp 

13.4 Registry access privileges 
To operate iControl LabMax™ 5.0 and iControl Mixing Guideline, the logged in user needs read/write access 
to the following keys including all subkeys: 

HKEY_LOCAL_MACHINE\SOFTWARE\Mettler Toledo 

13.5 Network access privileges 
In general iControl LabMax™ 5.0 does not require any network access privileges, but if iControl LabMax™ 5.0 
is needed to communicate to an iC 5.0 (or newer) application which resides on the network, then the UDP 
and TCP ports described below need to be open: 

13.5.1 UDP Ports 

All iControl 4.0 (and newer) and iC 4.0 (and newer) application use UDP broadcasts on the UDP port 1001 
(default) to find each other. This happens only if the user presses “Find METTLER TOLEDO Applications” on 
each of those iControl and iC applications (in iControl LabMax™, this button can be found on the 
configuration display for the iC instrument on the ‘Manage Equipment’ dialog). 
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Note that it is not required to have this port open, the UDB broadcast is only used to find and exchange the 
Hostname and TCP port settings to connect the iControl or iC applications.  All the actual communications 
are then done on a TCP link. 

This default UDP port can be changed in the following XML file by setting a different Broadcast Port: 

C:\Documents and Settings\All Users\Application Data\METTLER TOLEDO\ApplicationInfo.config.xml 

<?xml version="1.0" standalone="yes"?> 

<AppInfos> 

 <AppInfo> 

    <Title>iControl</Title> 

    <AppType>iControlLabMaxTM</AppType> 

    <Version>5.0.20.0</Version> 

    <Host>ch03w0713.eu.mt.mtnet</Host> 

    <Path>C:\Program Files\METTLER TOLEDO\iControl LabMax 5.0\iControlLabMax.exe </Path> 

    <Port>3906</Port> 

    <Index>0</Index> 

  </AppInfo> 

  <OtherDefaults> 

    <BroadcastPort>1001</BroadcastPort> 

  </OtherDefaults> 

</AppInfos> 

NOTE: This file is created when iControl starts up the first time. 

13.5.2 TCP Ports  

By default, iControl LabMaxTM communicates with other iControl or iC applications on the network over TCP 
port 3903. This default port can also be changed in the XML file using the Tag <Port> (sample XML file see 
previous chapter).  
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